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Getting Started with
Dreamweaver MX 2004

Many years ago the famous concert pianist, and sometimes composer, Glenn Gould wrote a musi-
cal composition called “So You Want to Write a Fugue.” In it he took the listener through the tools
and steps necessary to write a composition in this musical form. This book attempts to achieve the
same idea. Our form is going to be a Web site and our tool is going to be Dreamweaver MX 2004.

As you will see, Dreamweaver provides ease of use if you are a beginner who wants to build a
simple site for a hobby, like The Cooking Place you will create in Section 1, and it provides sophis-
tication if you are designing the Web site of a major company, like the MediaEdge site you will
build in Section 3.

Dreamweaver achieves this diversity by presenting a simple, word-processor-like interface that
allows you to type text and arrange graphics as you wish. While you do this, Dreamweaver gener-
ates the necessary programming code in the background. If you are somewhat experienced in Web
coding, Dreamweaver allows you to edit and manipulate the code yourself.

As your needs get more demanding, Dreamweaver becomes an easy-to-use interface between
higher programming languages and database programs. It enables you to drop database fields
easily into your Web site and assists you in writing the code necessary to achieve dynamic effects.

There is no question that the technological demands of the Internet are growing. At one time Web
designers simply used a descriptive language called HTML to build their pages. While HTML is
just as important as it always was, you can also use a host of other technologies (such as scripting
languages, Microsoft Active Server Pages, Macromedia ColdFusion, XML, and so on) to reach new
levels of functionality.

The Dreamweaver IDE (integrated development environment) helps you harness these robust
technologies quickly and easily. In many cases, a few simple menu selections is all Dreamweaver
needs to write complex code. By eliminating the need to code by hand, Dreamweaver gives your
projects quicker turnaround times so you can meet your deadlines better. In computer parlance,
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this is called rapid application development (RAD). As exciting as all this sounds, you must start at the
beginning. Before you can do anything you must set up a few things. This chapter shows you how to do
the following;:

0O  Learn how Dreamweaver can assist you in creating Web sites.

0  Install the tools you need to work through this book: the Dreamweaver MX 2004 Integrated
Development Environment and Microsoft IIS (Internet Information Services) Web server.

O  Set up the Dreamweaver workspace to suit your personal needs.

Over the course of Section 1, you build a Web site on the subject of food and cooking. You gain some
familiarity with Dreamweaver and learn the fundamentals of Web development.

As you progress through the book, you'll learn a lot about HTML, scripting languages, and ASP, and see
how Dreamweaver helps you create great Web sites using these important technologies.

A Brief Overview of Web Technology

You're probably quite familiar with using the Web. You open a browser, enter a Web site address (or click
a button or link), and then, after a short time, see a page appear in the browser. It’s simple!

Before you can request that Web page, however, somebody somewhere has to go through the trouble of
creating and publishing it. They may even have used Dreamweaver to do that.

This section gives you a quick overview of creating a Web page and serving it to the browser. This proce-
dure lies at the root of everything else you do in this book.

Static Web Pages

When the Web was first born (and even for a while after it started to become more widespread) all pages
published on the Web were static pages. A static Web page is one that, like a piece of paper, is created
once and never changes.

Even now, there are plenty of static pages out there on the Web, containing text, graphics, images, hyper-
links (links to other pages), and so on. The thing about a static Web page is that it always looks the same,
regardless of who visits the page, when they visit it, or how they arrive at the page. The only time a
static Web page changes is when the designer (Webmaster or Web author) physically locates the page
file, opens it, and edits it.

HyperText Markup Language (HTML)

Static Web pages are composed using a language called HyperText Markup Language (HTML). This is a
markup language whose purpose is to describe the content, layout, and positioning of all the elements on a
page (text and graphics used). Later you'll learn about programming languages, which perform actions
such as making decisions or repeating a block of code a certain number of times.
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Here’s a simple example of an HTML document:

<html>
<head>
<title>Welcome to Beginning Dreamweaver MX 2004</title>
</head>
<body>
<hl>Welcome!</hl>
<p>
This is the first example in Wrox’s <i>Beginning Dreamweaver MX</i>
book. To learn more about Wrox books, go to
<a href="http://www.wrox.com” >www.wrox.com</a>.
</p>
</body>
</html>

HTML is composed of tags (the things enclosed in <...> characters) and text. Tags tell the browser how
and where to display text:

Q  The phrase “Welcome to Beginning Dreamweaver MX 2004” sits between a <title>tagand a
</title> tag. This tag tells the browser that this phrase should be displayed in the browser
window’s title bar.

Q  The phrase “This is the first example...” sits between a <p> tag and a </p> tag. These paragraph
tags tell the browser that this phrase should be displayed as a paragraph.

This HTML example would usually be contained in an .htmor .html file. When this Web page is dis-
played in a browser, it looks something like Figure 1-1.

] Welcome to Beginning Dreamweaver MX 2004 - Microsoft Internet Explorer =t
File Edit View Favorites Tools Help i
- — n . — >
€ _/J \ﬂ \ELI f A P ) Search ‘i:( Favorites @ Media Q‘E vh L_f
Address ﬁéj http:flocalhostfthecookingplace/welcome. hitm [V] Go
Welcome!

This 15 the first example in Wrox's Beginning Dreamweaver MY book. To learn more about
Wrox books, go to www. wrox com.

ﬁ:l ‘:J Local intranet
Figure 1-1
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As Figure 1-1 shows, the HTML in this example also describes the following:

O  The placement and format of the header “Welcome!” (in a larger font)
0 Some italicized text (between <i> and </1i> tags)

QO  Ahyperlink to www.wrox . com (also known as an anchor, which is why HTML uses <a> and
</a> tags to describe it)

There are different ways that authors of Web pages can generate HTML:

O  They can type the HTML into a text editor such as Notepad.
O More likely they can design and compose Web pages using a product like Dreamweaver, which

generates the HTML for them.

Don’t worry too much about the finer details of HTML for now. You will learn as much as you need
about HTML tags as you progress through the book. The main question for now is how HTML gets to
the browser.

How a Web Page Gets to the Browser
The page, its content, and layout are completely determined by the HTML. No matter who visits the page,
or when they visit it, it always looks the same—unless the author of the page rewrites it.

How does a static Web page appear on a browser? It’s about clients and servers, and requests and
responses. Figure 1-2 illustrates the entire process.

WEB SERVER

@ Author writes

@ Web server locates .htm file
HTML

@ HTML stream (from .htm page)
returned to browser

@ Client
requests Web page

@ Browser processes HTML
and displays page

CLIENT

Figure 1-2
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There are two machines in this diagram—a server and a client:

Q  The client is the machine on which users run their Web browser, which they use to request a
Web page

Q  The server is a machine that runs the Web server software—the software that manages Web
pages and makes them available to client machines (over the Internet or a local network)

In Step 1, an author composes the HTML file, saves it, and publishes it on a Web server. Any time after
that, a user (using a browser on a client machine) types a Web address into the browser, or clicks the but-
ton, to make a request for the page (Step 2).

This request travels across the Internet (or the local network) and arrives at the Web server, which locates
the .htm file that was requested (Step 3) and sends it back to the client machine (Step 4) as a response. If
the HTML refers to any other files (such as images), then they are also sent as part of the response.

Finally, when the browser receives the response, it interprets the HTML tags and text and displays them
on the screen as instructed by the HTML (Step 5). It surprises many people to learn they aren’t looking at
a Web page directly on the Web server but, instead, are viewing code that was downloaded to their own
machine and interpreted by their browser.

Dynamic Web Content

As the Internet evolved, the limitations of static HTML pages became apparent:

Q  Designers couldn’t write a page that would display the name of whoever was looking at it.

O  Designers couldn’t write a page that would reflect reality at any given moment, such as the cur-
rent time or the latest weather conditions.

0  Designers couldn’t write a page whose content depended on choices users had made on the
page they just came from.

Because Web authors needed something more flexible, dynamic Web content evolved. A dynamic Web page
is a page that can contain both prewritten HTML and instructions for generating customized HTML.

For example, have you ever gone to a Web page that identifies you by name or gives you the weather for
your town? When a user requests a dynamic Web page, the response they get is still HTML; however,
some (or all) of that HTML is generated by software on the server after the user requests the page.
Therefore, it can react to the user’s actions, the current situation, or the latest information that is available.

Server-Side Processing

Suppose you want to see list of all books written by Ernest Hemingway that Amazon.com carries. To do
this, you type www.amazon.com in the Address box of your browser (this is called the Uniform Resource
Locator or URL). You then type Hemingway into a text box (this is called a Web form, which you'll learn
about in Chapter 6) and click a button to submit this request.

Amazon.com has information on millions of titles; how does its Web server know what information to
show you? The answer is that the Web server analyzes the information your browser sends when you
request the page and detects that you typed “Hemingway” into the text box. The Web server then sends
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the necessary information to a database server, which finds all the books whose author is Hemingway.
Once the database server completes its task, it sends the list back to the Web server, where one of the
dynamic technologies writes the necessary HTML code to display the list properly in your Web browser.
Once that code is generated, it is sent back to your browser, which interprets the HTML and displays the
page, just as it would a static page. Although this is a slight simplification, it helps you understand the
fundamental concepts of the process.

This Web page is generated dynamically by the Web server at the time it’s requested. You can compare
the request/response process in Figure 1-3 with the process for a static page (in Figure 1-2). As you can
see, there’s only one extra step (Step 4).

WEB SERVER

@ Web server locates instructions file
@ Author writes

instructions @ Web server processes instructions to create HTML

@ HTML stream returned to browser

@ Client
requests Web page

|\- @ Browser processes HTML

= and displays page

CLIENT

Figure 1-3

This example introduces another layer of technology called a database server. It allows the Web server to
interface with the database. This type of server, which has a specific job, is sometimes called an applica-
tion server.

In general, the capability of generating customized HTML is not automatically built into a Web server.
You need to add this dynamic technology to your server. There are several technologies available that
do the job more or less well:
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0  Active Server Pages (ASP): Developed by Microsoft, this technology comes as part of its IIS
Web browser.

Q  ColdFusion: This technology was developed by Macromedia (the same people who created
Dreamweaver). It requires installing the ColdFusion application server.

Q  JavaServer Pages (JSP): An offshoot of the Java programming language, it requires the installa-
tion of a Java application server.

Q  PHP: This growing dynamic technology is supported by many of today’s most popular Web
browsers.

0  ASP.NET: This is the newest of the dynamic technologies and was developed by Microsoft as
part of its NET development environment. It requires installing the NET Framework Server to
function.

There are pros and cons to all of these technologies, which are discussed in other books. For the pur-
poses of this book, the dynamic examples will use IIS as the Web server and ASP as the dynamic technol-
ogy. IIS comes bundled with Windows 2000 Professional or Windows XP Professional. ASP is part of IIS
and does not require any additional software to be installed.

Simple HTML isn’t enough to support these dynamic technologies; you need a more mature language.
Scripting languages offer a lot more capability than HTML but are not as complex as full-fledged pro-
gramming languages such as Visual Basic or Java. We will be speaking a bit more about these languages
further on in the book.

Client-Side Processing

Dynamic technology operates on the Web server. You can also write code that executes on the client.
The effect is quite different.

Client-side code is not executed by the Web server. Instead, it is sent to the browser (along with HTML,
as part of the response) and is processed by the browser; the browser then displays the results on the
user’s screen.

You can use client-side code to bring a page to life by making it react to the user’s button clicks and
mouse movements. For example, you could have rollover effects make a button change colors when the
mouse pointer is over it, or you could create a way to verify that information in a form is correct before
the browser sends it to the server.

Figure 1-4 extends the picture a little further by adding one more step (Step 6) to take care of client-side
processing:

For your client-side code to work, the client machine (or browser) must support the language in which
the code is written. JavaScript is probably the most commonly used language for writing client-side
code. It’s supported by all the major browsers (Internet Explorer, Netscape, Opera, and so on). As
Chapter 2 explains, when you use Dreamweaver to create dynamic client-side effects, it generates
JavaScript client-side code to power those effects.



03 555243 Ch0l.gxd 12/15/03 9:23 AM Page 10 $

Chapter 1

WEB SERVER

@ Web server locates page file

3
@ Author writes —
page code @ Web server asks script engines to

process scripts and generate HTML

HTML stream passed
back to client

@ Client
requests page

@ Browser processes
client-side scripts

Pr/’; @ Browser processes HTML
pg_v and displays page

CLIENT

Figure 1-4

The Macromedia Suite

In 2003 Macromedia released its Studio MX 2004 development environment. The MX 2004 environment
was developed to better encompass newer Web technologies, such as the Microsoft .NET environment,
and to help streamline the work process.

Studio MX 2004 is an integrated suite of development tools that consists of the following products:

QO Flash MX 2004 delivers professional animation Web sites that lend themselves to being viewed
with mobile technologies by needing fewer resources to run.

O  Fireworks MX 2004 develops exciting, attractive graphics.

ColdFusion MX 6.1 provides server technology for delivering dynamic Web content.

(]

0  Dreamweaver MX 2004 is the principal development tool for bringing all the other components
together.

10
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Installing Dreamweaver MX 2004

There are several ways to obtain Dreamweaver MX 2004. You can download a 30-day evaluation copy
from www . macromedia.com. You can purchase it by itself or buy it bundled with the Macromedia
Studio MX 2004 suite. The installation process for all these versions is similar, with just a few minor
differences.

The following section steps you through installing Dreamweaver MX 2004. The screenshots were taken
from the Macromedia Dreamweaver MX 2004 installation disk, running Windows XP Professional. If
you install it on a different operating system, or from a different source, you might see some differences.
The overall process should not vary much, however.

Try It Out Installing Dreamweaver MX 2004

1. Run the installation program. If you're installing Dreamweaver from a CD, the installation pro-
gram probably runs automatically when you insert the disc. If not, select Start=>Run, click the
Browse button, and browse to the Dreamweaver MX 2004 installer (called Dreamweaver MX
2004), as shown in Figure 1-5.

=) C\Dec ts and Setting \My Dec sl load'Dr 2004 =IO
File Edit View Favorites Tools Help "
) ) ®)
€ &) 1? 7 Search [} Folders v
Address |uﬂ C:\Documents and Settingsiuserity Documentsidownload\Dreamweawver 2004 [V] GO Marton Antivirus E -

File and Folder Tasks ) dreamneaver 2004,
) Macomedia..........
(2) Make a new Folder
8 Publish this Folder to the
‘teh

{? Share this Folder

Other Places £l

(= downlosd

(L) My Documents
() Shared Documents
i My Computer

&3 My Metwork Places

Details ¥

Figure 1-5

11
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2. Double-click the installer icon to extract the necessary files. After that is completed, you are
invited to install Dreamweaver MX 2004, as shown in Figure 1-6.

Macromedia Dreamweaver MX 2004 Installation

Welcome to the InstallShield Wizard for
Macromedia Dreamweaver MX 2004

The Install5hield® Wizard will install Macromedia
Dreamweaver M 2004 on your computer. To continue,
click Mext.

macromedia
MX

Mext > | Cancel

Figure 1-6

3. Readand accept the License Agreement, as shown in Figure 1-7, by clicking Yes.

Macromedia Dreamweaver MX 2004 Installation

License Agreement

Flease read the following licenze agreement carefully.

Press the PAGE DOWMN key to see the rest of the agreement.

MACROMEDIAR) SOFTWARE EMD USER LICEMSE AGREEMENT ||

ATTEMTION: Y0OU M&Y MEED TO SCROLL DOWN TO THE END OF THIS ELILA
EEFDRE v0OU CAM AGREE TO THE EULA AND COMTIMNUE WATH THE SOFT'WARE
IMSTALLATIOM.

IMPORTAMT: THIS SOFTWARE EMD USER LICENSE AGREEMENT ["ELILA" IS A
LEGAL AGREEMEMNT BETWEEN YOU [EITHER AM INDIVIDUAL OF, IF PURCHASED
0OR OTHERWISE ACOUIRED BY OR FOR AM ENTITY, &N ENTITY] AND |

Do you accept all the terms of the preceding License Agreement? |f you choose Mo, the
setup will close. To install Macromedia Dreamweaver ki< 2004, you must accept this
agreement.

¢ Back Yes Mo

Figure 1-7

12
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4. Dreamweaver allows you to decide what directory to install it in, as shown in Figure 1-8. In most
instances, the default setting is fine.

Macromedia Dreamweaver MX 2004 Installation

Choose Destination Location

Select folder where Setup will install files.
Setup will inztall Macromedia Dreamweaver kM 2004 in the following folder.

Ta install to this folder, click Mest. Toinstall to a different folder, click Browse and selact
anather folder.

Destination Folder

C:AL M acromediahDireamweaver Mx 2004 Browse...
< Back Mext » | Cancel |

Figure 1-8

5.  The next screen (see Figure 1-9) is an interesting one. It shows you all the technologies that
Dreamweaver MX 2004 can handle, and asks you if you want the files associated with these
technologies to use Dreamweaver as their default editor. You can simply check which files you
want to associate automatically with Dreamweaver MX 2004.

Macromedia Dreamweaver MX 2004 Installation
Default Editor

Dreamweaver will zet itzell a= default editor for the following file types.

IV Active Server Pages (asp)

v JavaServer Pages [jsp)

v ColdFusion [cfm, cfe)

[+ ASP.MET [aspx. ascx)]

¥ PHF [php. php3. phpd)

IV JavaScrpt [jg]

[+ Cascading Style Sheets [css)

v Estensible Markup Language [xmi]

< Back Mext » | Cancel

Figure 1-9

13
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6. Double-check your installation settings before the process begins, as shown in Figure 1-10.
Macromedia Dreamweaver MX 2004 Installation
Start Copying Files
Feview zettings before copying files.
Setup haz enough infarmation to start copying the program files. If you want ta review or
change any settings, click Back. |f you are zatisfied with the settings. click Mext to begin
copying files.
Current Settings:
Target Directory:
C:%Program Filezhh acromediat\Dreamweaver M 2004
Start Menu - Program Folder:
Macromedia
Default E ditor For:
azp.jsp.cfm,chc.aspx.ascy php.php3.phpd jz.css.2mil. Ibi.dwt, mno.ste.as, asr.dwr
< Back Mext > | Cancel
Figure 1-10

Click Next to begin the installation process. When completed, you will be prompted to click
Finish. Depending on your configuration, you may be taken to the Dreamweaver MX 2004 icon
and a page on the Macromedia Web site that contains some introductory text.

How It Works

This process installs all the necessary files and performs the configuration required to get Dreamweaver
working. When it’s complete, the Dreamweaver development environment will be ready to use. If you

want, you can load Dreamweaver from the Start menu, using Programse>Macromedias>Macromedia
Dreamweaver MX 2004.

By installing Dreamweaver MX 2004, you have access to a powerful code editor. If all you want to
do is write static Web pages, your job is done. However, that would be using only a small part of

Dreamweaver’s capability. A major feature of this program is its ability to integrate with the server
technologies we described above.

Installing a Web Server

As you've probably guessed from the discussion earlier in this chapter, you need a Web server in order

to build the Web sites in this book. The choice of Web servers available to you depends on which operat-
ing system you're using;:

Q  If you're using Windows 2000 (Professional, Server, or Advanced Server editions) or Windows

XP (Professional Edition), the easiest thing to do is install Microsoft IIS Web server software.

14
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Q  If you're using any other operating system, you need to consult Appendix E (or the
Dreamweaver documentation) to find out more about how to use a remote Web server.
Discussing the various possible combinations is beyond the scope of this chapter.

The exercises in this book use IIS Web server software, which is bundled with the versions of Windows
2000 and Windows XP listed previously.

IIS version 5.0 is supplied as part of Windows 2000, while Windows XP Professional ships with IIS
version 5.1. For your purposes, there is not much difference between the two, so whichever version is
supplied with your operating system will do. Please note that, as of this writing, Microsoft is releasing
1IS version 6.0. Based on initial information, it should not present any differences when using
Dreamweaver.

For the purposes of this book, we use the default installation. Your installation parameters may vary
depending on your circumstances.

TryltOut | Installing and Testing IIS 5.

There are several ways to install IIS. If you are using Windows 2000 or XP Professional, just follow this
simple procedure:

1. Launch your Windows 2000 or XP installation CD. The screen shown in Figure 1-11 appears.
Select the Install Optional Windows Components option.

T elcome to Microso NAows

N f Welcome to Microsoft Windows XP

ﬁ What do you want to do?

(3] Install Windows XP
\§| Install optional Windows components
[>] Perform additional tasks

[3] Check system compatibility

Figure 1-11

15
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2.  If the Internet Information Services (IIS) option is already checked (see the dialog box shown in
Figure 1-12), IIS is already installed. Click Cancel and skip to Step 4 to test it. Otherwise, click
this check box and then click Next.

Windows Components Wizard

Windows Components
You can add or remove components of Windows XP.

To add or remove a component, click the checkbos. & shaded box means that only
part of the companent will be instaled. To zee what's included in a companent, click
Details.

Components:
8 Intemet Explarer 0.0 ME 4\

Intarmet | nformation 5 ervices [115] 159MB |

Al Matagement and Monitaring Tools 19MB

[ = Meszage Queuing 0OME
W] s SN F eninrer 137 MR [

Description:  Includes “eb and FTP support, along with support for FrontPage,
tranzactions, Active Server Pages, and database connections.

Total digk space required: 26.9 MEB -
Details...
Space available on disk: 7E18.8 MEB eals

< Back ” Mext > l[ Cancel ]

Figure 1-12

3.  Click Next. The Wizard installs and configures the IIS components. As it does, it displays a
status bar to inform you of the progress of the installation. After it finishes, you see a message
that tells you that you have “successfully completed the Windows Components Wizard.” Click
Finish to close the Wizard.

You don’t have to start the IIS installation from the operating system CD. Instead, you can get to the
dialog box in Step 2 by selecting Starte>Control Panel in Windows XP (or StarteSettingsw Control
Panel in Windows 2000), clicking Add or Remove Programs, and then Add/Remove Windows
Components. From there, follow Steps 2 and 3. When you reach Step 3 you'll be asked to insert the
operating system CD or specify the place on your network where the installation files exist.

4. Tt'sagood idea to test the IIS installation now to ensure that ASP is running. Do this using
the same machine onto which you’ve just installed IIS. Open your Web browser, type
http://localhost/localstart.asp in the Address box and click Go. It should display the page
shown in Figure 1-13, which states that your Web service is now running.

How It Works

Once you install IIS, it starts running automatically and continues to run in the background, listening for
Web page requests.

In Step 4, you used a Web browser to make a request for a Web page at an address of http://
localhost/localstart.asp. There are three important elements to this address:

16



03 555243 Ch0l.gxd 12/15/03 9:23 AM Page 17

Getting Started with Dreamweaver MX 2004

Q  Starting at the end, localstart.asp is the name of the Web page you requested. It doesn’t
have an . htm extension. Because it has an . asp extension, it in fact uses the ASP server-side
technology mentioned earlier. ASP is installed as part of IIS, so the page should work just fine.

Q  Before that, the bit just after the // indicates the location of the Web server on which you expect
this page to be hosted. Here you specify “localhost” to indicate that you're trying to contact the
Web server that’s on the same machine as the browser.

Q  Before that, the address begins with http://. This causes the Web page request to be trans-
ported from the browser to the Web server using something called HyperText Transfer Protocol, or
HTTP. HTTP is the protocol used by the Web to describe both requests and responses. Think of
it as a standard format for Web requests and Web responses. Because HTTP is a standard, all
Web servers and browsers and other machines on the Internet can understand the request or
response message being sent.

@ Welcome to Windows XP Server Internet Services - Microsoft Internet Explorer ==
File Edit View Favorites Tools Help :,"
» = n — »
o 1 Y ) o = ~ - !
@ Back </ \i’.l @ W | Seatch ‘__/_\{ Favotites @ Media {‘} T
Address |@j httpifflocalhost/localstart, asp [v] @
e
1 =
Microsoft
W. d S
Professional
Your Web service is now running.
You do not currently have a default Web page established for your users.
Any users attempting to connect to your Web site from another machine are
currently receiving an Under Construction page. Your Web server lists the
following files as possible default Web pages:
default.htm,default.asp,index.htm,iisstart.asp,default.asps. Currently, only
iisstart.asp exists.
To add documents to your default Web site, save files in
cyinetpublwwwrooth,.
;'o';alcor{lle ;I' IISt_S.IS . S} 5.1 @ Integrated Management
f;rel\:?;’osgfsm:t::sr\ls ztl;‘V::‘Cfosfe(ssio)nai Tou can manage 115 through the
bri h £ Wb ting © Windows ¥P Computer Management
\'\:’_lngs e\'ﬂ.ott":'elgg e Compu_llng ho console or by using scripting. Using the
f'Im owds. 'It » ¥OU Gan &asi YtS are console, you can also share the contents
E: esliggtio?ﬂrsmtoe;sejcfl'r”glou Eabﬂs%rea % of your sites and servers that are
inl?cgrmation an the Weg tpo improve the manaded with Intsrnet Information
i2ati b P Services to other people via the web,
m?gr:noa:{oargl?glzi? ;Dsnescuigeslaﬁorm far Accessing the 115 snap-in fram the
buildin anci denlovin e—corﬂmerce console, you can configure the most
i 9 4 ploy g il cormmon 115 settings and properties.,
=0 ul.'o'l.s ant n:;jss'\o'vn Er' iea After site and application development,
applications to the Web. these settings and properties can be used
in a production environment running
Using windows =P Professional with IIS more powerful versions of Windows
installed, provides a personal and SEFYErs,
development operating systemn that [V]
@1 Done ‘-j Local intranet ”
Figure 1-13
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In this case, the browser and the Web server are on the same machine. But that isn’t always the case. If
you have a network set up, you should be able to browse to the localstart .asp page on your IIS Web
server from other machines on your network (using an address like http://<iis-machine-name>/
localstart.asp).

Be particularly sensitive to security risks if your Web server is exposed to the public
Internet. There are plenty of precautions you can take. For example, download the nec-
essary security patches as they become available, using Windows Update (http://
windowsupdate.microsoft .com), or use some sort of Firewall configuration.

If everything works properly, your browser should display a test page like the one shown in Figure 1-13.
If you don’t get this page, don’t panic; it could be that something very simple is wrong. Here are a few
suggestions to rectify the situation:

O  If your browser displays the message “The page cannot be found” or “HTTP 404 File Not
Found,” it means that your page request reaches the Web server all right but the Web server
can’t find the page you're looking for. Perhaps you misspelled the name of the page. Check it
and try again.

Q  If your browser displays the message “The page cannot be displayed,” “Cannot find server,” or
“DNS error,” it means that your page request does not reach the Web server. In this case, it
could be that you misspelled the name of the Web server in the page address. Check it and try
again.

O  If you confirm the address still get the same problem, it could be that the installation process
failed to start the Web server. To check this, select Starte>Control Panel=> Administrative Tools=>
Services in Windows XP (or Starte>Settingse>Control Panel=> Administrative Toolse>Services in
Windows 2000). In the window (see Figure 1-14), look for the World Wide Web Publishing item.
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In the Status column, you should see the word “Started,” which indicates that the Web server is
running in the background and listening for page requests. If you do not see “Started,” right-
click World Wide Web Publishing and select Start to start the service.

If you continue to have problems with your IIS installation, or any other aspect of this book, contact
Wrox Support at techsupport@wrox.com.

Exploring Dreamweaver MX 2004

Provided that everything installs properly, you should be ready to start putting it to work. In this section
we show you how to use Dreamweaver to build a simple static Web page and then test it by viewing it
in a Web browser. We also take a short tour of the Dreamweaver workspace and introduce you to the dif-
ferent features that appear when the program launches. Once you complete the example and this little
tour, you'll know enough to get started on the Web site in Chapter 2.

Try It Out Building Your First Web Page

1. Ifyouhaven't done so already, launch Dreamweaver MX from your Start menu (this should be
Starte>(All) Programse>MacromediasoMacromedia Dreamweaver MX 2004). If this is the first
time you are running it, you will be prompted to decide how you want Dreamweaver to open,
as shown in Figure 1-15.

Workspace Setup
Please choose the work space layout you prefer. “You can switch lapouts later in
Preferences.
T TT)
2 L o
it
.E E =)
— a0l
— =)
O a3
e a3
a0
Ll
afl
| S [ | a1
|+ | e PN P
(%) Desigrer () Coder

Figure 1-15

If you primarily want to work in a design mode, select Designer; if you like to jump into the
code right away, select Code. Whatever you select here can be easily changed later on. If you are
new to Web design, you will probably find Designer a bit easier to work with initially.

Also, if you are using Dreamweaver MX 2004 for the first time, you will be prompted to enter
your serial number information, as shown in Figure 1-16
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d' Macromedia Product Activation

Enter your serial number

macromedia
i

wihere's my serial number?
Need a Serial Number?
Buy one online using your web
browser.

By

Type vour serial number into
this screen bo activate vour
software,

‘? activation Help

a Privacy Policy

Figure 1-16

2.  You should see an introductory page similar to Figure 1-17. The first column shows the Web
sites you have been working on recently. The second column lists the types of Web pages you
can create. The third column lists sample pages you can use as guides for your work. This is
convenient if you are new to Web design.

If you do not want to see this screen in the future, select Don’t Show Again.
3.  From the second column, Create New, select HTML.
4. You should see the Dreamweaver MX screen, as shown in Figure 1-18.
If you open in Code view, click the Design button located in the upper-left corner of the work area, just

below the tabs.

This is the place where you do most of the development in this book. As you can see, there’s
quite a lot in this window. The next section describes the Dreamweaver workspace.
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dm dia D MX 2004
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Figure 1-17

‘d Macromedia Dreamweaver MX 2004 - [Untitled Docu (Untitl ea-“ I!H ML)]
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Figure 1-18
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5.  Now you're ready to create your first Web page. You could build this page using
Dreamweaver’s powerful features for designing and building Web pages, but to keep things
brief in this first chapter, just type the necessary code instead. (You'll see plenty of those page
design features in the rest of the book.)

Near the top left of the window, under the Document Name tab and just to the right of the word
“View,” you will see three buttons arranged as shown in Figure 1-19. If you float your mouse
pointer over the three buttons, Dreamweaver tells you what they are for. If you select Code
view, you should see a screen similar to the one shown in Figure 1-20. This is the HTML code.

Unkitled-1

42| Code I‘-_"Split (4| Design | Title: | Y
— Ran
g

Show Design wiew

Figure 1-19

Untitled-1
| ] code | =5 splc | 5] Design | Title: [untied Document w2 M @, | o E
1 <!DOCTYPE htwl PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" "hetp://wnr, w3, org/TR/Xhtull/DTD/xhtull-trar
2 <html xmlns="http:// www. w3.org/1999/xhtml ">
3 <head>
4 <vitlexUntitled Document</ritle>
5§ <meta http-equiv="Content-Type" content="text/html; charset=iso-3§59-1" />
6 <sheads
7
8 <body]
9 < bodys
10 </hrml>
11
< i [2]
<body = 1K) 1 sec
Figure 1-20

6. Change the existing code in this pane so that it reads as follows:

<!DOCTYPE HTML PUBLIC “-//W3C//DTD HTML 4.01 Transitional//EN”>
<html>
<head>

<title>Welcome to Beginning Dreamweaver MX 2004</title>
</head>
<body>
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<hl>Welcome!</hl>
<p>
This is the first example in Wrox’s <i>Beginning Dreamweaver MX</i>
book. To learn more about Wrox books, go to
<a href="http://www.wrox.com” >www.wrox.com</as>.
</p>
</body>
</html>

Change only the lines highlighted here in gray. Alternatively, you can copy and paste the code from the
file called welcome . htm in the downloadable source code package for this book, available from

WWW.WXroxX.com.

7.  Click the Show Design View button. In Design view, shown in Figure 1-21, Dreamweaver allows
you to preview your work. More importantly, you can use this view to design pages, which
means that most of the time you don’t have to deal with code at all.

“ﬂ Code ﬂSpht MDeslgn‘ Title: | Welcome ta Beginning Dreamw @;f 04, @' | ™ '

Welcome!

This is the first example in Wrox's Beginning Dreamweaver MY book. To leam more about Wrox books, go to
. WO, COMML

<body > 794 % 444 » 1K | 1 sec

Figure 1-21

8.  Save the file. Because you have not set up a Web site yet, keep this simple and just save it in the
default My Documents folder. From the menu bar at the top of the window, choose Filer>Save As
and then use the Save As dialog box to navigate to the My Documents folder (see Figure 1-22).
Save the file with the name welcome.htm.

After you select Save, the tab located in the upper-left corner of the document window identifies this
work as the welcome . htm document.

9. Testthe page by viewing it in a Web browser. Dreamweaver has an easy way to do this. Pressing
F12 causes a browser window to appear, with your page loaded in it, as shown in Figure 1-23.
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Figure 1-23
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10. Doesn’titlook great? However, there is one small issue here. Look at the address displayed in
the Address box in the browser: It doesn’t begin with http://. This means that Dreamweaver
isn’t making the page request through the HTTP protocol; the operating system, rather than the
IIS Web server, is displaying the page in the browser instead.

This happens only because you have not yet configured Dreamweaver to set up a test Web site
from which it can request pages through HTTP. You'll do that in Chapter 2.

How It Works
You examined the HTML code for this page earlier in the chapter, so we won't go over it again. It is
worth noting the two views that you used in the exercise, however:
Q  Code view allows you to view and edit the code that makes up your Web page.
O  Design view allows you to view and edit the design of your page.
By switching from Design view to Code view, adding some code, and switching back again, you can see

the relationship between these two views. If you make a change in one view, the change affects whatever
is in the other. In many ways, Design view is similar to working in a word processor.

From Chapter 2 onwards, you will begin to make much more use of Design view, and Dreamweaver’s
design tools, to build your pages.

If you want, you can see the HTML that the Web server sends to the browser. To do this, right-click the
browser window and select View Source (or View Page Source or similar, depending on your browser),
as shown in Figure 1-24.

o welcome[1] - Notepad [B[=]x]
File Edit Format View Help

<! DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitiona
<html=
<head:
<titlexwelcome to Beginning Dreamweaver M@ 2004« Tt
</heads
<hody>
<hlzwelcome! </ Hl=
<
This 4= the first example in wrox's <i=Beginning D
book. To learn more about wrox books, go to
/<a href="http: /v, wrox. Com" >www. wrox, Com</ax.
</
</hody>
</html s

[(] 11l [)]
Figure 1-24

This shows the code that the Web server sends to the browser and which the browser uses to build the
page you see.
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The Dreamweaver Workspace

Dreamweaver’s workspace is standardized with the entire Macromedia MX 2004 environment. Many of the
features here work the same way as their counterparts in the other Studio MX 2004 programs—Flash MX
2004, Fireworks MX 2004, and so on. This reduces the overall learning curve for the MX 2004 environment.

Beginning with the previous version, Dreamweaver MX, Macromedia dramatically redesigned the envi-
ronment to emphasize organization and ease of use. The standard workspace is shown in Figure 1-25.

Document Tab Document Window Property Inspector
Menu Bar Status Bar Panels Panel Groups
d Mdcromedia Dreamwedver MX 2004 - [Wellcome to Beginnifg Dreamweaver MY 2004 (TheCookingPlace/welcome Jitm)] =/=E
File [Edit View Insert’ Modify Text Commands Site| Window Help
Layout ¥ Standard | Expafded | Layout | 17 oot [~ B | ¥ Design = -
Layers
| ~
L -0 x [Crrevent cverlaps
_ i z
|+2| Code ‘jSDI\t|iDes\gn @ Title: Welcpme to Beginning Dreatw ."L_’f it & ™ 'E‘_ [ lame: [
iW elcome!
This 15 the first example in Wrox's Begiwng Dreamweaver MY book. To learn morp about Wrox books, go to T - |
WWW.WIOE.COm. - =
e i ¥ Application =4
i ¥ Tag <h1:> =
Behaviors
s=|m= [ 4 = 4 «
i ¥ Files =
Files
1) thecookingplace | | | Local view | |
Q|2 @ ¥ a|E
<body= <hl> 502 % 431 » 1K/ 1 s¢c g ¥ indes.htm ~
ii ¥ Properties i : i= oL ¥ Index_backup.him
® ~1d @ mm_menu.js
Format Heading 1 w | Style | Mone v B I v S5 3 -1 ¥ news.htm
Font Default Font |« | Size one |s E B &= & ¥ recipes. htm
= = @ regions.htm
e
hd
~le »
i P Resuls 1 local items selected totalling 346 bytes
Figure 1-25

Panel Groups and Panels

One of the most important concepts about the work environment is the use of panels and panel groups,
as shown in Figure 1-26.

26



03 555243 ChOl.gxd 12/15/03 9:23 AM Page 27 $

Getting Started with Dreamweaver MX 2004

i Design
i p Code
it P Application

il w Tag <body>=

-
Bl

Abtribikes e | e e
=| &
£z &

General
Browser specific

55/ Accessibility
Language
Uncategorized

Figure 1-26

A panel is a group of related tools. They are usually located along the right side of the workspace. For
example, the Behaviors panel groups tools for client and server-side behaviors using dynamic technolo-
gies. Instead of describing all of the many panels available now, we discuss them as you need them
through the book.

If you are using Dreamweaver for the first time, you'll see a few panels open on the right. More panels
are available from the Window menu. For example, to open the History panel, select Window=>History
(or press Shift+F10). The panel should appear on the right.

The MX 2004 environment helps you to stay organized further by grouping related panels into panel
groups. For instance, the Selection panel group contains the Properties, Behaviors, and CSS panels.

Hiding and Revealing Panel Groups

You can close, regroup, or rename panel groups to suit your demands. As you become more familiar
with Dreamweaver, you may decide to customize your panel groups by selecting the control box to the
right of the name in the panel group title bar (see Figure 1-27).

1 i w Tag <body> §|
Edit Tag
Tag Library

Help —

Group Tag Inspector with » }—

Maximize panel group
Close panel group

o
Figure 1-27

You can also collapse a panel group by clicking on the arrow to the left of the name in the group’s title
bar (see Figure 1-28).

Figure 1-28

27

.



03 555243 Ch0l.gxd 12/15/03 9:23 AM Page 28 $

Chapter 1

Moving and Docking Panel Groups

To move a panel group around the workspace, you must pick it up by its gripper—the pattern of dots in
the top-left corner of the panel group—as shown in Figure 1-29, and move it to its new location. This
allows you to do the following:

0O Undock a panel group so that it is not displayed with the other panel groups but floats in a sep-
arate “window.”
0O  Dock an undocked panel group to move it back into the main Dreamweaver workspace window.

0  Change the order of the docked panel groups by dragging the panel group by its gripper and
dropping it in its new location.

. Attributes
| B
Figure 1-29

The Property Inspector

Holding a special place of honor, at the bottom of the workspace, is a very important panel called the
Property inspector. The Property inspector is where you view and change the properties of whatever
element or item you've selected in your document. The Property inspector is context-sensitive: If your
cursor is inside an HTML paragraph, the Property inspector shows the properties of that paragraph
(see Figure 1-30); if you select a JavaScript behavior, the Property inspector shows the properties of that
behavior.

ii ¥ Properties =
FDI’mat‘Paragraph [vl Styla|Nnne [v] B 7 i IV]QEI @)

ant‘ Default Fort [vl Size | Mane lv] D

N
Page Properties...

Figure 1-30

Figure 1-30 shows the properties of an HTML paragraph (<p>) element: The font selected for this para-
graph is the default font, there is no set font size, and so on. The buttons on the right enable you to apply
bold or italic, adjust the alignment (left, center, right, or justified), add bullets, and do various other
things. You’ll make good use of these options over the coming chapters.

The Insert Panel Group

Along the top of the screen is the Insert panel group (see Figure 1-31). This panel group contains many
of the tools commonly used for controlling layout and text, creating and controlling tables, and creating
frames, forms, and so on.
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Common ¥ @E&|%@vév|-$

Figure 1-31

Many of the tools in this panel group are hidden until needed. To access the other panels, click the
Common button located at the beginning of this panel, as shown in Figure 1-32.

File Edit WView Insd

® Common
Layout

Forms

Text

HTML
Application
Flash elements
Favorites

Show as Tabs

Figure 1-32

New to this version of Dreamweaver is the ability to create a customized panel in this group called
Favorites, shown in Figure 1-33. Use this to group tools that you use a lot but either aren’t on other
panels or are spread over different panels.

Favorites Right-click ko customize wour Favorite objects.

Figure 1-33

Right-click the mouse and select Customize Favorites. The Customize Favorite Objects dialog box shown
in Figure 1-34 opens to allow you to select the icons you use most.

Customize Favorite Objects
Awailable objects: Favorite objects: @ILI :I
Fireworks HTML
- Flash Text [»] Flash
- Shockwavye — Applet
- Applet
- param
- Activelk
- Plugin
- Date
- Comment
- Make Template
- Make Mested Template [V]
Figure 1-34
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Click on the Common menu selection to see a feature that users of past versions of Dreamweaver will
appreciate—the Show as Tabs feature, as shown in Figure 1-35.

File Edit View Insq

Common

Layout

Forms

Text

HTML

Application

Flash elements
® Favorites

Show aﬁ\Tabs
Figure 1-35

This changes the Insert panel to the older style used in previous versions of Dreamweaver, as shown in
Figure 1-36.

i w Insert Common © Layvouk | Farms | Texk | HTML | Application | Flash elements | Favarites

RELED-6-0RB-F
Figure 1-36

Setting up the Preview Browsers

The purpose of this book is to build Web sites. Therefore you're going to need a browser to test the fruits
of your work. As you've already seen, Dreamweaver allows you to view a Web page by pressing F12
(Preview in Browser). Dreamweaver is probably already configured to allow you to use Microsoft
Internet Explorer to view Web pages. However, it’s a good idea to install the latest versions of both
Internet Explorer and Netscape and to configure Dreamweaver so that it gives you an F12-type Preview
in Browser shortcut for each browser, not just one. That way you can check what you’ve done easily by
using whichever browser you're interested in.

Many Web developers retain earlier versions of the major browsers for testing purposes. When you pub-
lish your Web site, there is no guarantee that everyone who visits it will be using the latest and greatest
browser. For that reason, it’s a good idea to test your work under as many conditions as possible, and
with as many different browsers as possible. As you progress through this book, you will learn about
some of Dreamweaver’s additional tools that aid browser compatibility.

Before you begin this final exercise, find out which browsers you have installed already on your
machine, and consider installing additional ones. For example, get the latest version of Internet Explorer
from www.microsoft.com, get the most recent version of Netscape from www.netscape. com, and
download Opera, a popular alternate browser, from www . opera. com.
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Try It Out Configuring Dreamweaver for Browser-Based Page Previews

1. InDreamweaver, select Edit>Preferences to open the Dreamweaver Preferences dialog box, as
shown in Figure 1-37. Click the Preview in Browser category.

Preferences
Zategary Preview in Browset
General
Accessibility .
Code Coloring Browsers: [#] =]
Code Format P
Code Hints iexplore  F12
Code Rewriting
€55 Styles

File Types [ Editars
Fonts

Highlighting
Invisible Elements
Layers

Layout Mode

Mew Document Defaults: Primary browser
Office Copy/Paste
Pangls [ secondary browser
Preview in Browser
Site Options: [ Preview using kemporary File
Status Bar
Walidator Checking this option will create a temporary copy for preview and

server debugging. To update the dacument directly please uncheck

this aption.

oK I [ Cancel ] [ Help

Figure 1-37

2.  Check the browser for which Dreamweaver has already been configured. If your Browsers box
contains an entry, click on it and then click the Edit button. The Edit Browser dialog box shown
in Figure 1-38 appears.

Edit Browser

Mame: | iexplare]

Application: | C:\Program Files\Internet Exploreriie

Defaulks: [v]Primary browser
[]5econdary browser

QK l [ Cancel

Figure 1-38

This dialog box tells you the name of the browser. It also specifies the file that runs whenever
you use this option. (Figure 1-38 shows Dreamweaver configured to preview Web pages with
Internet Explorer.) Don’t change the settings here; just click OK to close the dialog box.

3. Add a second browser. Click the plus button to bring up the Add Browser dialog box.

If your Dreamweaver installation is already configured to use Internet Explorer (as in Step 2),
and you've already installed Netscape, then configure Dreamweaver to allow previews in
Netscape as well:
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Q  For the Application field, browse to the executable file for Netscape (it is probably in a
folder such as C:\Program Files\Netscape\Netscape\Netscp7.exe) so that the
dialog box looks like the one in Figure 1-39.

Add Browser

Mame: | Metscp.exe

Application: | C:\Pragram Files\NetscapeiMetscape

Defaults: [ Primary browser
Secondary browser

[ Ok l [ Cancel

Figure 1-39

Alternatively, if Dreamweaver is not already configured for Internet Explorer and you want to
configure it here, do so:

Q  For the Name field, type Internet Explorer 7 (or something similar).

Q  For the Application field, browse to the executable file for Internet Explorer (it is proba-
bly somewhere like C:\Program Files\Internet Explorer\iexplore.exe).

Click the Primary Browser or Secondary Browser check box. (This is simply for convenience’s
sake. Press F12 to preview in the primary browser and press Ctrl+F12 to preview in the secondary
browser.) Click OK to exit the Add Browser dialog box.

In the Preferences dialog box you should now see the browsers listed in the Browsers box, as
shown in Figure 1-40.

Browsers; :-__I_-__j E]

iexplore  F1z
Metscape 7.0 Chrl F12

Defaults: [ Primary browser
Secondary browser

Figure 1-40

If you make Netscape your secondary browser, you should find that Internet Explorer has been
configured automatically as the primary browser.

You have one other thing to decide regarding how Dreamweaver uses browsers, and that is the
Preview Using Temporary File option (which is also in the Preferences dialog box). Uncheck this
option and click OK to exit the Preferences dialog box.

Test the configuration. Press F12 to view welcome.htmin your primary browser; press Ctrl+F12
to view it in your secondary browser, as shown in Figure 1-41.

.



03 555243 Ch0l.gxd 12/15/03 9:23 AM Page 33 $

Getting Started with Dreamweaver MX 2004

@ Welcome to Beginning Dr X 2004 - Netscape B[E[=|
. File Edit VWiew Go Bookmarks Tools Window Help

| @ Q @ Q |%Imp:-'.-'cehrown."'BegASPNET.-"My".-‘oZODocumne!s-'welcome.htm |[G\ Search] égc @

. /B, =Mail £AIM 4 Home G2 Radio [ Netscape €l Search @] Shop FIBookmarks
&) | % Welcome to Beginning Dreamw... l (%]

Welcome!

This is the first example in Wrox's Beginning Dreamweaver MX bool. To learn more about Wroz books, go to www.wrox com,

S = & oF £ oo Fa el
Figure 1-41

How It Works

You can add as many browsers as you like to the list. Make one of them your primary browser and
another one your secondary browser. This enables you to preview pages in those browsers using the F12
or Ctrl+F12 keyboard shortcuts. Once you add other previewing browsers, use them by right-clicking
the page in the Files panel of the Files panel group and selecting the Preview in Browser option.

If you are unsure how to get there, open the panel by either selecting the Files Panel group or pressing F8.
(You could also select Windowr>File.)

If you keep the Preview Using Temporary File option checked, Dreamweaver doesn’t preview the actual
file you're working on. Instead, it creates a temporary file. The problem with this arrangement is that
each time you edit the file, you must start a new browser session to preview it; refreshing the current
browser view doesn’t work. Temporary files also create clutter. (Dreamweaver is supposed to delete these
temporary files when it shuts down but our experience has shown that this does not always happen.)

If you uncheck the Preview Using Temporary File option, you must save the file before previewing it. This
is not really a hassle, however. It's good practice anyway to save your work frequently. Going this route
also prevents temporary files from cluttering your folders or uploading them accidentally to the server.
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Chapter 1

Summary

Dreamweaver is a powerful tool for building Web sites. As you saw in this chapter, Dreamweaver gives
you easy access to code in Code view. Perhaps more importantly, it also gives you a Design view and a

wealth of powerful tools that you can use to generate code quickly and accurately. This means that you
can quickly get down to the task of building attractive Web sites with minimal effort.

It’s helpful to know what happens behind the scenes and to picture the request/response process that
occurs whenever someone wants to see a Web page. The user’s browser formulates an HTTP request
message (describing the request) and sends that request across the Internet (or other network) to the
Web server. When the Web server receives the request, it processes it and returns an HTTP response,
containing the requested page, to the browser. The browser finally displays the page on the screen.

This is the request/response in its simplest form, of course. We touched on the notion of client-side and
server-side processing, and how they bring dynamic effects and dynamic content to Web pages. You'll
learn more about client-side processing in Chapter 2 and server-side processing in Section 2.

You're now ready to create a Web site—The Cooking Place—and build the pages that comprise the site,
along with graphics and client-side effects.

Why Not Try .

1. Take a moment to explore the various panels of the Insert panel group. You'll find that the Insert
panel group is a versatile and powerful tool, enabling you to add many different elements and
features to your Web pages. You'll learn more about them in the coming chapters. For now,
however, use the buttons in the Common panel to add more elements to welcome.htm.

N

Add and remove buttons from the Favorites panel located in the Insert panel group.

3.  Look at the different panel groups and panels in Dreamweaver. The best way to access all the
different panels is by using the Window menu (which lists the relevant keyboard shortcut for
each panel). You have already seen a little of the Insert panel group and the Properties panel
(the Property inspector). You'll meet many more over the course of the upcoming chapters. For
now, just look around and see what'’s available.
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